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1. Introduction 

The PROMODI program was developed as part of the Drilling Engineering Association's DEA- 

67 project to "Develop and Evaluate Slim-Hole and Coiled-Tubing Technology." The program 

calculates oil, water, and gas production rate, as well as pressure drop along the wellbore, based on the 

wellbore configuration and reservoir properties. It can be used for 1) velocity string design, 2) nodal 

analysis, and 	 3) gas-lift calculations. 

The program describes the complex multiphase flow in reservoir, wellbore, choke, and surface 

pipe lines. It uses Fetkovich's equations for flow in gas reservoirs and Vogel's or PI equations for flow 

in oil reservoirs. The multiphase flow in wellbores and pipe lines is handled by several multiphase flow 

equations including Beggs-Brill, Hagedorn-Brown, Hasan-Kabir, and Duns and Ros. A few other 

empirical correlations are used to describe the multiphase flow through the choke. A gas lift option is 

also included with the program. The injection depth can be specified anywhere along the wellbore. 

-	 PROMODl calculates production rate by solving reservoir and wellbore flow equations 

simultaneously. It also outputs the pressure profiles along the wellbore, the liquid hold-up distribution, 

gas and liquid velocities, and flow regime map along the wellbore. These results are displayed both in - rc.r 	 tabular and graphic forms. 

- Two types of inflowloutflow performance curves are provided, based on the solution node the 

user chooses. If the bottom-hole node is selected, the program displays two sets of bottom-hole pressures 

against production rates calculated from reservoir and tubing equations (including choke and surface line), 

- respectively. When the wellhead node is selected, the program displays two sets of wellhead pressures 

against production rates calculated from reservoir plus tubing equations and choke plus surface line 

equations, respectively. The production point is determined by the cross point between these two sets -
of curves. In addition, the program calculates and displays the minimum production rate required for 

continuous removal of liquid from the wellbore, based on the droplet model developed by Turner et al., 1%9. 

1.1 MODEL FEATURES OF PROMOD 

The key features of PROMOD are its ability to: 

1. 	 Handle both oil and gas wells 

2. 	 Deal with 3-D wellbores 

3. 	 Handle 15 sections of tubing strings and 10 well intervals (including casing strings and open- 
hole sections) 

4. 	 Select 1 of 4 correlations for multiphase flow 

5. 	 Select 1 of 2 solubility correlations for oil wells 



6. Select 1 of 3 choke flow correlations or no choke at all 

7. Include the gas lift option for oil wells 

8. Input up to 3 reservoir pressures or production rates for comparison 

9. Choice of unit systems: English or Metric 

The output window is a compilation of "child" windows of text reports and graphs, which 

includes: 

1. Tabulated results 

2. Flow regime profiles 

3. Pressure distributions 

4. Liquid hold-up profiles 

5. Liquid and gas velocities 

6. Inflow/outflow performance curves with the bottom-hole or wellhead as the node 

7. Minimum gas rate for continuous removal of liquid from gas wells 

1.2 REQUIRED INPUT DATA 

There are five data files associated with PROMODl. 

1. Well Data File (.WDI) 

a. Company and project name 

b. Well locations 

c. Date and comments 

2. Survey Data File (.SDI) 

a. Directional survey data for the well. 
and zero inclination 

3. Tubular Data File (.VTI) 

a. Length, ID and OD of tubing string 

Survey must start with zero depth, zero azimuth, 

b. Length and ID of casing string and open-hole section 

c. Surface line length, deviation, and ID 

d. Choke size 

e. Perforation depth 

f. Flow path either through tubing or annulus 

4. Parameter Data File (.VPI) 

a. Well type: oil or gas well 

b. Rate data 

c. Oil and gas properties 

d. Temperature data 



e. Productivity data 

f. Gas lift data (optional) 

5. Project Data File (.VJl) 

a.  Stores the names of the four files mentioned above and the units used. 

All input data saved on disk or in memory are in the English system of units. 

1.3 DISCLAIMER 

No warranty or representation is expressed or implied with respect to these programs or 

documentation including their quality, performance, merchantability, or fitness for a particular purpose. 

1.4 COPYRIGHT 

Participants in DEA-67 can provide data output from this copyrighted program to their affiliates 

and can duplicate the program and manual for their in-house use, but are not to give copies of the 

program or this manual to third parties. 





2. Theory and Equations 

2.1 INTRODUCTION 

A typical well production system, a gas well or  an oil well, consists of several components 

including: 

1. Flow through porous medium 

2. Flow through vertical or directional wellbore 

3. Flow through choke 

4. Flow through surface line 

Figure 2-1 shows a schematic of a simple producing system. 

Each component affects the well production rate and pressure loss in a different way. A 

systematic approach has to be used to solve the total producing system. In doing so, nodes are placed 

to segment the portion defined by different equations or correlations. 

surface line 

choke 

well head 

tubing 

bottom hole 

rese~o i r  

Figure 2-1. Well Production System 

Two nodes are used in the program to segment the production system: 1) node No. 5 at the - bottom of the hole and 2) node No. 3 at  the wellhead. When the bottom-hole node is used, the system 

is segmented into a reservoir component and a well component which includes tubing, choke and surface 

- line. When flowing through the annulus, the well component includes the annulus between the tubing 

Z-
and casing, the choke and the surface pipe line (Figure 2-2). 



bonorn hole 

Figure 2-2. System Segmentation with Bottom-Hole Node 

When the wellhead node is selected, the system is segmented into a surface component and a sub- 

surface component. The surface component includes the choke and surface pipe line. The sub-surface 

component includes the reservoir and tubing or ~ M U ~ U S(Figure 2-3). 

@ choke 

@ well head 

@ tubing 

@ bollam hole 

Figure 2-3. System Segmentation with Wellhead Node 



2.2 SOLUTION PROCEDURE FOR BOTTOM-HOLE NODE 

Figure 2-2 shows the two segmented components when the bottom-hole node is selected: 

reservoir and tubing components. For a given production rate, the bottom-hole pressure can be 

calculated in two ways: 1) from the reservoir component using inflow equations and 2) from the tubing 

component using multiphase flow correlations for pipes and chokes. Suppose the reservoir inflow is 

represented by the following equation: 

where fl(Q) is the pressure loss across the reservoir. A plot of Pd against Q from this equation is 
called the inflow performance curve, an example of which is shown in Figure 2 4  (solid data points). 

Equation (2-1) can take different forms depending on the fluid produced and the reservoir properties. 

Detailed descriptions are provided in later sections. 

Another way of determining PWfis to use multiphase correlations for flow in tubing, choke, and 

surface lines. For a known outlet pressure, Pout, the following equation gives the relationship between 

production rate and bottom-hole pressure: 

f2(Q) = pressure loss across tubing 


f3(Q) = pressure loss across choke 


f4(Q) = pressure loss across surface line 


A plot of Pwf against Q from this equation is called the outflow performance curve (Figure 2 4 ,  

open data points). Equation 2-2 can take quite different forms, depending on the multiphase flow 

correlations used. There are several correlations available; four of them are included in the current 

version of the program. All of the correlations used in the program are presented in a later section. 
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Figure 2-4. Inflow and Outtlow Performance Curves with Bottom-Hole Node 

These two different ways of calculating Pd result in two curves as shown in Figure 2-4. The 

cross point of these two curves gives the production rate and the corresponding bottom-hole pressure for 

the production system. If there is no cross point between these two curves (Figure 2-5), the production 

system ceases producing any fluid because reservoir pressure is inadequate to lift the fluid out of the 

well. This inadequacy can be the result of declining reservoir pressure or too much energy loss in the 

tubing, choke, or surface line. A recompletion or an artificial lift method is required for such conditions. 
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Figure 2-5. Inflow and Outflow Curves do not Intersect 

' - A  	 2.3 SOLUTION PROCEDURE FOR WELLHEAD NODE 

Figure 2-3 shows the two segmented components, surface and sub-surface, when the wellhead - node is used. Accordingly, for a given production rate, the wellhead pressure can be calculated in two 

different ways from the surface and sub-surface components. Surface components include the choke and 

-	 the surface line with known outlet pressure. For any production rate, the wellhead pressure can be 

calculated by adding the pressure loss across the surface line and the choke to the outlet pressure: 

a A plot of PWhagainst Q from Eq. (2-3) is called outflow performance curve (Figure 2-6). It can 

be determined using different empirical correlations for flows in the surface line and the choke. Details 

- will be presented in a later section. 

Another way of determining the wellhead pressure is to use the sub-surface component. It 

'-	
consists of two sections: 1) the reservoir flow, and 2) the flow in tubing or annulus. The calculation 

begins with the reservoir pressure. For the given rate, bottom-hole pressure can be determined using 

the reservoir equation. Once the bottom-hole pressure is hown,  the wellhead pressure is then calculated 

-- using the multiphase correlations for flows in tubing or annulus. The process is described in the 

following equation: 



P,h = Pr - f l  (Q) - f2 (Q) (24) 

A plot of Pwh against Q from Eq (24) is called the inflow performance c w e  (Figure 2-6). 

Figure 2-6. Inflow and Outflow Performance Curves with 

Wellhead as the Node 


The cross point of the inflow and outflow performance curves provides the production rate and 

the wellhead pressure shown in Figure 2-6. If there is no cross point between these two c w e s ,  the well 

ceases production. A recompletion or a lift method is required. 

2.4 RESERVOIR INFLOW PERFORMANCE EQUATIONS 

The preparation of inflow performance relationship (IPR) curves for oil and gas wells is 

extremely important in production systems analysis. Unless some idea of the productive capacity of a 

well can be established, the design and optimization of the piping system becomes difficult. This section 

presents two flow equations for oil reservoirs and one equation for gas reservoirs. 

2.4.1 PI Eauation for Oil Reservoirs 

When the bottom-hole pressure is higher than the bubble-point pressure, single-phase liquid 

flow results, since all of the gas dissolves in the oil. The production can be calculated using Darcy's 

equation from a vertical well with closed outer boundary (Brown, 1984). 



7.08 x k, h 
P I  = -

pOBO ( In  r,lrw - 0.75 + S" + a 'q)  

where: 


PI productivity index stbldlpsi 


effective permeability (md) 
ko 

h 	 effective feet of oil pay (ft) 

average reservoir pressure (psia) p, 
wellbore sandface flowing pressure at center of perforations (psia) pwf 

oil flow rate (stbld) 
% 

re radius of drainage (ft) 


rw radius of wellbore (ft) 


S" total skin 

turbulent flow term (The a'q term is normally not significant for low 
permeability wells and low flow rates) 

-
po = 	viscosity (cp) at average pressure of (P, + Pwf)12 

B, = 	formation volume factor at average pressure 

For a horizontal well, Joshi's equation can be used (Joshi, 1986). -
90 = P I  (P, - Pwf) 	 (2-7) 

2*kHh 
P I  = -	 -

Bp In 

where 

6 = Vertical Permeability (md) 

KH = Horizontal Permeability (md) 

L = Horizontal Well Length (ft) 

Equations (2-5) and (2-7) are denoted as PI equations in the program for solution gas 

driven oil wells. PI can be estimated using Eqs. (2-6) or (2-8) for vertical and horizontal wells, 

respectively. The user can modify those equations as necessary since only the input of PI is required. 

C 



It is noted that in the current version of the program, all production is assumed to be from 

a single perforation point. This assumption may be appropriate for a vertical well. For a horizontal 

well, the assumption may lead to erroneous results. However, if the pressure loss in the horizontal 

section is small, the error should not be significant. An improvement in this area is p l a ~ e d  for later 

versions when appropriate. 

2.4.2 Vo~el's Eauation for Oil Reservoirs 

A simplified solution to the two-phase flow problem was offered by Vogel (1968). He 

gave the following general equation to account for two-phase flow in the reservoir (saturation effects): 

He arrived at this equation from a computer solution to several solution-gasdrive 

reservoirs and for different fluid properties. Figure 2-7 may also be used to arrive at a solution. His 

solution has been found to be very good and is widely used in the prediction of IPR curves where two- 

phase flow exists (liquid and gas). It appears to work reasonably well for water percentages up to 50%. 

PRODUCING RAE(qo/tqo ),,I, FRACTION OFMAXIMUM 

Figure 2-7. 	 Inflow Performance Relationship for Solution- 
Gas-Drive Reservoirs (After Vogel) 

2.4.3 Fetkovich's Eaustion for Gm Reservoirs 

One of the most common equations for gas rate prediction is the back-pressure equation, 

which takes the form of the following: 



where: = gas production rate MSCFD Q, 

P, = average reservoir pressure, psi 

Pwf = bottom-hole pressure, psi 

c = coefficient from well data 

n = exponent obtained from well tests 

Note that c and n are usually determined based on the well testing data, which may not 

be practical from an economic viewpoint. Economic practicality is hampered by the fact that the well 

is probably already in the loaded condition. Thus, in order for the test data to be meaninm, the well 

would have to be put into an unloaded condition and maintained in that condition for the duration of the testing. 

Rather than go the expense of this type of testing, it is often felt that it is adequate to apply 

a method for predicting future IPR curves. One such method is that of the Fetkovich equation shown 

below (SPE 4529): 

where: P, = current average reservoir pressure 

Pwf = bottom-hole pressure 

Pi = initial reservoir pressure 

c = coefficient from testing data when pressure is at Pi 

n = exponent from testing data when pressure is at Pi 

Using a method such as this allows any testing to be limited to a bottom-hole pressure 

build-up test to determine the current reservoir pressure. Once the IPR curve has been determined, it 

can be cross plotted on the tubing performance curve plot. The intersection of these two curves indicates 

- where the well will produce with that particular set of tubulars and conditions. 

2.5 MULTIPHASE CORRELATIONS FOR FLOW IN WELLBORE OR SURFACE LINES -
As discussed earlier, the modeling of production systems involves a large amount of calculation 

of multiphase flow in wellbores and surface pipe lines. There is a number of correlations available in -
the industry for this purpose. However, none of the multiphase flow correlations works well across the 

full range of conditions encountered in oil and gas fields. Thus, in order to get a realistic tubing - performance curve, great care should be taken to ensure that the input variables are as realistic as - possible. The correlan'ons described belo~v use SZ units. The pressure drop calculated from these 

- correlations has to be converted to English units before being used. 



2.5.1 Bepes-Brill Correlalion ( B e e s  and Brill. 19731 

This empirical correlation was developed from airlwater two-phase flow experiments. 

It applies to pipes of all inclination angles. The following is the procedure to calculate the liquid holdup: 

(1) 	 Calculate total flux rate 

Vm= "sl+ Vsg (2-1 3) 

(2) 	 Calculate no-slip holdup 

(3) 	 Calculate the Froude number, NFR 
.7 

(4) 	 Calculate liquid velocity number 

(5) 	 To determine the flow pattern which would exist if flow were horizontal, calculate 
the correlating parameters, L1, L;!, L3, and L4: 

(6) 	 Determine flow pattern using the following limits: 

Segregated: 

h ,<0.01  and NFR <L1  

or 

h,2 0.01 and NFR < L;! 

Transition: 


& 20 .01  and L2<NFR <Lj 




Intermittent: 

0.01 4A,<0.4 and L3 <NFR4L1  

or 

h,20 .4  and L3<NFR 4L4 

Distributed: 

L ~ 0 . 4and NFR>L1 

or 

L 2 0 . 4  and NFR>L4 

(7) Calculate the horizontal holdup A, 

where a, b, and c are determined for each flow pattern from the table: 

Flow Pattern a b c 

Segregated 0.98 0.4846 0.0868 
Intermittent 0.845 0.5351 0.0173 
Distributed 1.065 0.5824 0.0609 

(8) Calculate the inclination correction factor coefficient. 

where d,  e, f, and g are determined for each flow condition from the table: 

Flow Pattern d e f g 

Segregated uphill 
Intermittent uphill 
Distributed uphill 

0.011 
2.96 
No Corr

-3.768 
0.305 

ection 

3.539 
-0.4473 
C = O  

-1.614 
0.0978 

All flow patterns 
downhill 4.70 -0.3692 0.1244 -0.5056 

(9) Calculate the liquid holdup inclination correction factor 

where 0 is the deviation from horizontal axis. 



(10) Calculate the liquid holdup 

x = A,$ 

(11) Apply Palmer correction factor: 

A = 0.918 * A  for uphill flow 
X = 0.541 .A  for downhill flow 

(12) When flow is in transition pattern, take the average as follows: 

where A1 is the liquid holdup calculated assuming flow is segregated, A2 is the liquid 

holdup assuming the flow is intermittent. 

(13) Calculate frictional factor ratio 

f -tP = e 6  (2-25) 
fns 

where 

S = In (Y) 

-0.0523 + 3.182111(y) - 0.8725 [ln (y)F+ 0.01853 [ln (y)? 


S becomes unbounded at a point in the interval 1 < y < 1.2; and for y in this 

interval, the function S is calculated from 

(14) Calculate frictional pressure gradient 

(NRe)- = ~ , * v , . d e l h  

Use this no-slip Reynolds number to calculate no-slip friction factor, f,', using 

Moody's diagram, then convert it into Fanning friction factor, f, = ~ ' 1 4 .  The 

two-phase friction factor will be 



The frictional pressure gradient is 

2.5.2 Haeedorn-Brown Correlation lBrown and Beeps. 1977) 

The correlation used here is actually a combination of two correlations: Hagedorn-Brown 

correlation for slug flow and Griffith correlation for bubble flow. They apply only to vertical wells. 

Check the flow regime to determine whether to continue with the Hagedorn-Brown 

correlation or  proceed to the Griffith correlation for bubble flow. 

If A < 0.13, then A = 0.13. 

If B-A is positive or has a value of zero, continue with the Hagedorn-Brown correlation. 
e 


If B-A is negative, proceed with the Griffith correlation. 


Griffith correlation: 




Hagedorn-Brown correlation: 

(1) Calculate liquid viscosity number and coefficient. 

If NL < = 0.002, then CNL = 0.0019 

If NL > = 0.4, then, CNL = 0.0115 

(2) Calculate liquid, gas velocity number, and pipe diameter number. 



(3) Determine the secondary correction factor correlating parameter 

(4) Calculate liquid holdup 

(5) Calculate frictional pressure gradient. 

f = Fanning friction factor 

p, = no-slip average of densities 


p, = slip average of densities 


2.5.3 	 Hasan-Kabir Correlation (Hasan and Kabir. 19921 

This correlation is a recent development in multiphase flow technology. It was established 

based on hydrodynamic conditions and experiment observations. It applies to flow in annuli of 

inclination up to 80". 

1. Flow pattern identification. 

The flow occurs in four different patterns depending on the superficial velocities and 

properties. Figure 2-8 shows a typical flow regime map for wellbores. 
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Figure 2-8. Typical Flow Regime Map for Wellbores 

a) Boundary A: transition from bubbly flow to slug or churn flow 

v = (0.429 v,l + 0.357 v,) sin8sg 

8: deviation from horizontal axis. 

b) Boundary B: transition from bubbly or slug flow to dispersed bubble 

When d < dc and when superficial gas velocity stays on the left of Boundary C. 

Then the flow is in dispersed bubble. 

c) Boundary C: transition from slug to dispersed bubble. 

v = 1.083 v,, + 0.52 v, (2-39)
sg 



d) Boundary D: transition from slug to annular flow. 

2. 	 Liquid holdup calculation. 

For bubbly or dispersed bubble flow 

For slug or churn flow 
-

vt = 0.345 + 0.1 - (1 + H cos[ ::I 

A = 1 - (a .ATB + 0.25 vsg) if vSg < 0.4 

For annular flow 



3. Frictional pressure gradient calculation. 

For bubble, slug, or dispersed bubble flow 

For a ~ u l a r  flow 
I 

~f vsgc < 4 x lo4, then 


E = 0.0055 (lo4 v,,,)~-*~ 


If vsgc 2 4 x lo4, then 


E = 0.857 . log (lo4 vsgJ - 0.2 

2.5.4 	 Duns and Rm Correlation (Sixth World Petroleum Conmess] 

The Duns and Ros correlation is a result of an extensive laboratory study in which liquid 

holdup and pressure gradients were measured. Correlations were developed for slip velocity (from which 

holdup can be calculated) and friction factor for each of three flow regimes. 

1. Calculate the liquid viscosity number 

2. Find the liquid and gas velocity number 



3. Find the Pipe diameter number 

N', = d  -J :: 
4. 	 Calculate dimensionless quantities 

L, = 50 + 36 NLv 

0.75
L, = 75 + 84 NLv 

5. Find L, and in Figure 2-9. 

Figure 2-9. L-Factors Against Diameter Number Nd (after Ros) 

6. Determine flow regime 

Bubble flow = Or N, r L, + L, . N,, 

Slug flow = L, + L, NLv r N, s La 


Mist flow = N, > L, 

Transition = L, < N, < L, 


7. Determine the proper slip factor using the region found in the last step: 

a. Bubble flow 

F1 and F 2 are found in Figure 2-10. 

I F4
F3 = F3 - - where F3 and F4 are found in Figure 2-10. 
Nd 



For annular flow Nd is based on the wetted perimeter, thus: d = (d, + dJ. 

Figure 2-10. F1, F2, F3, and F4 Against Viscosity Number NL (After Ros). 

b. Slug flow 

F5, F6 and F7 can be found in Figure 2-11 where F6' = 0.029 Nd + F6 



Figure 2-11 .  F5, F6 and F7 Against Viscosity Number NL (After Ros) 

c. Mist flow 

1Therefore, HL = 
1 + Vsg/"sL 

8. Determine the slip velocity for bubble or  slug flow regime: 

9. Determine the liquid holdup: 

2 
VS - Vsg - VSL I/(Vs - Vsg - VSL) ~ V SVSL

HL = 
+ + 

2 vs 

10. Determine the liquid Reynolds number: 



11.  Determine the friction gradient according to the flow region: 

a. For bubble and slug flow 

where: 

fl is found in Figure 2-11 

f2 is found in Figure 2-12 


The abscissa must be determined in Figure 2-12 and is flR N~~ 

where: 

Figure 2-12. F1 Against Reynolds Re (After Ros) 



Figure 2-13. Bubble Friction Correction (After Ros) 

b. For mist flow 


In this region, the friction term is based on the gas phase only. Thus, 


Since there is no slip, the friction factor is given in a Moody diagram, but as a 

function of a Reynolds number of the gas: 

Duns and Ros noted that the wall roughness for mist flow is affected by the film of 

liquid on the wall of the pipe. The ripples of the wall film cause a drag on the gas. This process is 

governed by a form of the Weber number: 

and is also affected by liquid viscosity. This influence was accounted for by making Nwe a function of 

a dimensionless number containing liquid viscosity, 

- The functional relationship is shown in Figure 2-14 where the coordinates are Nwevs. 

.h Nwe Nfi. 

I 



The value of roughness may be very small but eld never becomes smaller than the value 

for the pipe itself. At the transition zone to slug flow, eld may approach 0.5. Between these limits, eld 

can be obtained from the following equations which were developed from Figure 2-14. 

Figure 2-14. Mist Flow Film Thickness 

where: 

a= = gas-liquid interfacial tension, dyneslcm 

p = gas density, lbmlf? 


v = superficial gas velocity, ftlsec, and 
sg 

d = pipe diameter, ft 


Values o f f  for the mist flow regime may be found for cld>0.005 from 

As the wave height on the pipe walls increase, the actual area through which the gas can 

flow is decreased, since the diameter open to flow of gas is d-E. Duns and Ros suggested that the 
v dZ 

prediction of friction loss could be refined by substitution of d-e for d and for vSg throughout 
( d - ~ ) ~  

the calculation of friction gradient. In this case, the determination of roughness, e,  is iterative. 



C 

-

In the transition zone between slug flow and mist flow, Duns and Ros suggested linear 

.h interpolation between the flow regime boundaries, L, and &, to obtain the pressure gradient. This- means that when N,, falls between L, and L,, pressure gradients must be calculated using both the slug 

flow correlations and the mist flow correlations. The pressure gradient in the transition zone is then 

calculated from 

where: 

Increased accuracy was claimed if the gas density used in the mist flow pressure gradient 

calculation was modified to 

where p is the gas density calculated at the given conditions of pressure and temperature. This g 
modification accounts for some of the liquid entrained in the gas. 

2.5.5 Grav Correlations (19741 

A vertical flow correlation for gas condensate wells was developed by H.E.Gray. It is - .A 

included in the vertical flow package in the computer program described in API 14bfor sizing subsurface 

safety valves. -
This program uses a pressure balance with a term, t ,  the gas volume fraction obtained from 

a fit of a few condensate data systems to build a simplified empirical model of a retrograde phenomenon 

requiring only specific gravity, pressure, and temperature data for input. 

The pressure balance equation used is: 

where 5, the gas volume fraction, is: 

205.0
1 - e x p  -0.2314 N,, 1 + -{ 1 [ sllBlt = R + l  




ID of flow conduit 


two-phase flow friction factor 


mass velocity 


depth 


pressure 


flow rate 


superficial liquidlgas ratio 


specific gravity 


gas gravity 


temperature 


velocity 


density 


mixture surface tension 


subscripts: 

f = friction effect 


g = gas phase 


i = inertia effect 


1 = liquid phase 


rn = gaslliquid ratio 


o = hydrocarbon condensate 


s = superficial value 


w = free-water phase 


The following indicates data ranges over which the Gray correlation was developed. Any 

calculations beyond the following acceptable guidelines should be viewed with caution: 

1. Flow velocities below 50 fps 

2. Tubing sizes below 3% in. 

3. Condensate production 50 bbl/MMscf 

4. Water production 5 bbl/MMscf 



The program was compared to 108 sets of well data. The results were found superior to 

dry-gas well predictions. The Gray correlation can be used to evaluate gas condensate wells by 

generating tubing performance J curves and comparing them to reservoir performance. Although the 

above restrictions should be considered, several calculations made with up to 300 bbllMMscf indicated 

less than a 10% error compared to data. 

2.5.6 Gas Well Liauid Loading-UD Process and ldentification 

2.5.6.1 Gas Well Load-UD Process 

As natural gas is produced from depletiondrive reservoirs, the energy available 

to transport the produced fluids to the surface declines. This transport energy eventually becomes low 

enough that flow rates are reduced and fluids produced with the gas are no longer carried to the surface. 

These liquids accumulate in the wellbore over time, and cause additional hydrostatic back pressure on 

the reservoir, which results in continued reduction of the available transport energy. In most cases, if 

this condition is allowed to continue, the wellbore will accumulate sufficient fluids to balance the 

available reservoir energy completely and cause the well to die. This phenomenon is known as gas well 

load-up (Figure 2-15). 

FLOWING LOADED 

LIQUID
FILM 

RISING 
FLOW 

. COLUMN 

-COLUMN 
GRADIENT 
0.08-wO.04 p i / R  I . I  
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. 
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Figure 2-15. Gas Well Load-Up Process (Coleman et  al., 1991) 

The liquid held in the wellbore comes from two sources: 1) liquids condensed 

from the gas, and 2) free liquids produced into the wellbore with the gas. Both liquid hydrocarbons and 

water may be present, depending on the specific reservoir. As Figure 2-15 illustrates, under normal 

production conditions, gas flows at a velocity high enough that an annular flow pattern develops (Figure 

2-15a). This flow pattern is characterized by the presence of a fast moving core of the gaseous phase 

carrying with it entrained droplets of the liquid phase. The remainder of the liquid phase is present in 

the form of a flowing film on the pipe wall. As the reservoir energy declines, gas velocity decreases, 



and the entrained liquid droplets in the gas core start to drop instead of being carried upwards. The 

liquid film starts to thicken and move downward at a higher velocity. These factors cause the liquid 

column at the bottom to rise. The well begins to load-up with liquid (Figure 2-15b). The rising liquid 

column increases the bottom-hole pressure, further reducing the gas production rate. Eventually, no 

liquid can be carried upward to the surface and the well will die (Figure 2-15c). 

2.5.6.2 Gas Well Load-UD Identification 

The liquid exists in the wellbore in two forms: 1) the liquid film along the wall 

of the pipe and 2) liquid droplets entrained in the high velocity gas core. Two models were developed 

by Turner et al., in 1969, to predict the onset of load-up based on two different assumptions: 

1. The continuous film model assumes that in order to keep a gas well 
from loading up, the annular liquid film must be moved upward along 
the walls. This model calculates the minimum rate of gas flow 
required to move the film upward. 

Figure 2-16. Liquid Film Movement (Turner et al., 1969) 

2. 	 The liquid droplet model assumes that the liquid droplets in the gas 
core are the controlling factor. If the liquid droplets cannot be carried 
upward, then the liquid will load-up in the gas well. This model 
predicts the minimum gas flow rate required to move the liquid 
droplets upwards. 



Figure 2-17. Entrained Drop Movement (Turner et al., 1969) 

After comparing the results from these two models with field data, Turner et al. 

found that the liquid film movement does not represent the controlling liquid transport mechanism, i.e., 

when the liquid film begins to fall back down the well, the film will thicken and bridge the pipe, causing 

the film to break up into drops, which will be carried up the hole by the gas (Figure 2-18). Therefore, 

the transport of entrained drops is the controlling mechanism and the minimum gas rate calculated from 

the entrained drop model is best used to identify the onset of the load-up. 

Figure 2-18 Fluid Movement Field Results 

2.5.6.3 Cri tical-Rate Theory (Liauid-Droolet Model) 

As Turner et al. showed, a free-falling particle in a fluid medium will reach a 

terminal velocity that is a function of the particle size, shape, and density and of the fluid-medium density 

and viscosity (Figure 2-18). 



Applying this concept to liquid droplets in a flowing column of gas, the terminal 

velocity, vt, of the drop is 

vt = c 1.6 ( [o"jpL - lp:) 

which assumes a fixed droplet shape, size, and drag coefficient and includes the +20% adjustment 

suggested by Turner et al. 

Applying this terminal velocity equation to wellbores and correcting to standard 

conditions, the minimum gas flow rate, G, for the continuous removal of liquids from a wellbore can 

be determined: 

q, = 3.06 pvt AlTz (2-76) 

Critical gas velocity, ftlsec 

Interfacial tension, dyneslcm 

Liquid density, lbmlcf 

Gas density, Ibmlcf 

Wellhead flowing pressure, psi 

Cross-sectional area for flow, ft2 

Temperature, O R  

Gas compressibility 

Critical gas flow rate, MMscfd 

This rate, also known as the critical rate, can be used to predict the onset of gas 

well load-up. Figure 2-19 plots this critical rate for typical 27/e-in. tubing with water as the droplet fluid. 
"C"If the gas production rate is above this critical rate, the well is not loading liquid at the bottom. 

in Eq. (2-74) is an adjustment factor. Turner et al., showed that an upward adjustment of 20% (i.e., 

c = 1.2) is needed to conform with the field data. However, Coleman et al. state that for wells with 
wellhead flowing pressure lower than 500 psi, the adjustment is not needed (i.e., c = 1). 



Figure 2-19 Wellbore Critical Rate: 2%-in. Tubing (Coleman et al., 1991) 

Eq. (2-74) can be simplified assuming: c = 1.2, a (water) = 60 dyneslcm, a 

(condensate) = 20 dyneslcm, p~ (water) = 67 lbmlcf, p~ (condensate) = 45 Ibmlcf. Gas density is a 

function of pressure, temperature and gas gravity. Further simplification is possible by using an average 

value of gas gravity (0.6) and gas temperature (120°F). The simplified equations are as follows: 

5.62(67 - 0.0031 p)' (2-77V, (water) = 
(0.0031 p)'h 

4.02(45 - 0.0031 p)U V, (condensate) = 
(0.0031 p)'h 

2.6 MULTIPHASE CORRELATIONS FOR FLOW IN CHOKES (BRILL AND BEGGS, 1991) 

Chokes are frequently installed in wells to restrict flow rates to desired levels. They normally 

operate in "Critical" or "Sonic" flow conditions (i.e., the velocity of the fluids through the choke 

reaches a level identical to the velocity of sound, pressure or compressional wave). Flow then becomes 

independent of downstream disturbance of pressure, temperature, or density because the disturbance 

cannot travel in the upstream direction. 

Most publications involving multiphase flow through chokes have been for critical flow. The 

problem solved in these works has been to calculate the pressure upstream from a choke, given the choke 

diameter, the liquid production rate, and the gaslliquid ratio. The alternate case is to calculate the liquid 

production rate given the upstream pressure. The equations andlor figures used to predict critical flow 

behavior through chokes are given below together with other information where pertinent. 



The equations proposed by Gilbert, Ros, Baxendell and Achong are all of the form 

where: 

PI = upstream pressure 

qL = liquid production rate, stbld 

Rp = producing gaslliquid ratio, scf1STBL 

d = choke diameter in 64th'~ of an inch 

A,B,C = empirical coefficients given in Table 2-1 

TABLE 2-1. 	 Empirical Coefficients for Two-Phase 
Critical Flow Correlations 

Correlation 	 A B C 
I I I

1 1  Gilbert 	 I 10.00 1 0.546 1 1.89 11 
Ros 	 17.40 0.500 2.00 

Baxendell 	 9.56 0.546 1.93 

(1 Achong 1 3.82 1 0.650 1 1.88 (1 

Analysis of Eq. (2-78) clearly shows that the production rate or fluid throughput is independent 

of the pressure downstream from the choke. As mentioned previously, this is a characteristic of critical flow. 

Equation (2-78) is also very sensitive to the choke size. Gilbert stated that an error of 11128 in. 

in bean size can cause errors of 5 to 20% in pressure estimates. Also, he pointed out that gas-liquid 

ratios are frequently reported only to the nearest 50 or 100 scf1STB and are frequently difficult to 

determine because of fluctuations which occur in many wells. These fluctuations can require changing 

choke sizes several times in a well's production history to obtain desired production rates. Finally, 

Gilbert stated that his formula (or coefficients) applies only when the upstream pressure (tubing pressure) 

is at least 70% greater than the line pressure (downstream pressure). When this percentage is less than 

70%, the bean size indicated will be too small for the given conditions. 



3. Program Installation 


3.1 BEFORE INSTALLING 

3.1.1 Hardware and Svstem Reauirements 

PROMODl is written in Visual ~ a s i c @ .  It runs in either standard or enhanced mode of 

Microsoft Windows 3.0 or higher. The basic requirements are: 

Any IBM-compatible machine built on the 80286 processor or 
higher (with math co-processor) 

2 megabytes of RAM; 4 megabytes is recommended 

Hard disk 

Mouse 

CGA, EGA, VGA, 8514, Hercules, or compatible display. (EGA 
or higher resolution is recommended) 

MS-DOS version 3.1 or higher 

Windows version 3.0 or higher in standard or enhanced mode 

For assistance with the installation or use of PROMODl contact: 

Weiping Yang or Russell Hall 

Maurer Engineering Inc. 


29 16 West T.C. Jester Boulevard 

Houston, Texas 77018-7098 U.S.A. 


Telephone: (7 13) 683-8227 Fax: (713) 683-6418 

Telex: 216556 


3.1.2 Check the P r o a a m  Disk 

The program disk you received is a 3%-inch, 1.44 MB disk containing twenty-one files. 

These twenty-one files are as follows: 



SmUPKlT.DLL 
VBRUN~OO.DLL 
VER.DLL 
COMMDLG. DLL 
GSWDLL.DLL 
GSW.EXE 
SmUP.EXE 
S ~ U P ~.EXE 
PROMOD1.EXE 
SmUP.LST 
CMDIALOG.VBX 
GAUGE.VBX 
GRAPH.VBX 
GRID.VBX 
MDICHLD.VBX 
THREED.VBX 
TEST.VI~ 
TEST.WD~ 
TEST.SD1 
TEST.^^ 

TEST.VPI 

We recommend that all .VBX and .DLL files that have the potential to be used by other 

DEA-44/67 Windows applications be installed in your Microsoft WINDOWS\SYSTEM subdirectory. 

This applies to all the .VBXs and .DLLs included here. The PROMODl executable (PROMOD1.EXE) 

file should be placed in its own directory (default "C:\PROMODlW) along with the example data files 

TEST.*. All these procedures will be done by a simple setup command explained in Section 3.2. 

In order to run PROMODl, the user must install all of the files into the appropriate 

directory on the hard disk. Please see Section 3.2 to setup PROMODl. 

It is recommended that the original diskette be kept as a backup, and that working diskettes 

be made from it. 

3.1.3 B a c k u ~  Disk 

It is advisable to make several backup copies of the program disk and place each in a 

different storage location. This minimizes the probability of all disks developing operational problems 

at the same time. 

The user can use the COPY or DISKCOPY command in DOS, or the COPY DISKETTE 

on the disk menu in the File Manager in Windows. 

3.2 INSTALLING PROMODl 

The following procedure will install PROMODI from the floppy drive onto working subdirectories 

of the hard disk (i.e., copy from A: or B: drive onto C: drive subdirectory PROMODl and 

WINDOWS\SYSTEM). 



1. Start Windows by typing "WIN" <ENTER> at the DOS prompt. 

2. Insert the program disk in drive B:\. 

3. In the File Manager of Windows, choose Run from the File menu. Type B:\setup and press Enter. 

4. Follow the on-screen instructions. 

This is all the user needs to setup PROMODI. After setup, there will be a new Program Manager 

Group which contains the icon for PROMODI as shown in Figure 3-1. 
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NeunWndowrMerdt TmIr  C s n a t  Mrrmolt Ganas M~aosoRE n d  
D a m  Rdasamal Access 4 0 

Figure 3-1. DEA APPLICATION GROUP Window Created by Setup 

3.3 STARTING PROMODl 

3.3.1 Start PROMODl from G r o w  Window 

To run PROMODl from Group Window, the user simply double-clicks the "PROMODI" 

icon, or when the icon is focused, press <ENTER>. 

3.3.2 Use Command-Line Oution from Windows 

In the Program Manager, choose Run from the File menu. Then type 

C:\PROMODl\PROMODl.EXE <ENTER >. 





4. 	 Running the Program 

4.1 INTRODUCTORY REMARKS 

PROMODl runs in a Microsoft Windows environment. It is assumed that the user is familiar with 

Windows, and that his or her computer is equipped with Windows 3.0 or a later version. 

For information about Windows in a concise and convenient form, 10 Minute Guide to Microsoft 

Windows 3 by Katherine Murray and Doug Sabotin, published by Sams, is recommended. 

In this quick start, step-by-step instructions take the user rapidly through the program. To save 
time and space, data will be input from the prefabricated files, TEST.*, which are included on the 

program disk and which are stored in directory C:\PROMODl during the SETUP process in Section 3.2. 

4.2 GETTING STARTED 

1. 	 Call up Windows and make DEA APPLICATION GROUP the active window, as shown in 

Figure 4- 1._-

-	 Figure 4-1. DEA APPLICATIONS GROUP Window 

2. Double click on the PROMODl icon. This displays the screen shown in Figure 4-2. Click - on the [OK] button and this opens the PROMODl front window shown in Figure 4-3. If the - [Exit] button is clicked on instead, the program returns to the program manager. 
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3. 	 The menu bar at the top of the screen facilitates all operations of the program. To access 

individual menu items, the user can utilize either a mouse or the keyboard. The four buttons 

on the left of the screen are used to speed access to the four data files. When a data file is 

ready, the name of the file is displayed in the grid on the right. The percent complete 

indicator shows the percentage of computation finished. 

4. 	 The "File" menu facilitates the operation of the project files. Click on the "File" menu and 

the "File" pulldown menu is displayed as shown in Figure 4-4. Click on individual items 

to perform the corresponding task. 

Figure 4-4. File Pull-Down Menu 

5 .  	 Before any calculation begins, the data have to be entered by reading an existing file or 

entered manually. Four data files need to be prepared. Three of them are absolutely required 

for any calculation. They are SDI, TDI, and PDI files. The fourth file, WDI, is for 

information only. The data in the WDI file do not go into any of the calculations. 

6. 	There are two ways to access the WDI file (Figure 46):  1) by clicldng on the Input menu 

as shown in Figure 4-5, then clicldng on WDI, or 2) by clicking on the [Show WDT] button only. 
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Figure 4-5. "Input" Pull-Down Menu 
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Figure 4-6. WDI Window 

4-4 




n The user can input all pertinent dam manually at this point or retrieve an existing file. To do that, - click on the menu "File" for the pulldown menu box as shown in Figure 4-7. Then, click on "open." 

This opens the file dialog box as shown in Figure 4-8 and highlights the file name to be retrieved. Click 

on the [OK] button and the WDI window is filled with the data from the file, shown in Figure 4-9. 
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Figure 4-7. WDI File Pull-Down Menu 
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Figure 4-8. File Dialog Box 
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- -WELL DATA INPUT Wit C1PROMODl\TEST.WDI I-la 
Rle 

Well Data Input Window 

Company Name: International Oil EBP Co. 

Rojen Name: p,o,ea#j 

Well Name: We11 # 5  


Field Name: 
 Austin Chalk 

CilyElate: Austin. Texas 

Date: 12-17-1993 

Comments: G a s  Well 

Figure 4-9. WDI Window Filled 

To exit from the WDI window, click on "File" and click "Return." 

7. 	Similarly, there are two ways to access the SDI file (Figure 4-10): 1) by clicking on [Show 

SDI], or 2) clicking on the "Input" menu and then clicking on "SDI." Either procedure will 

open the SDI window as shown in Figure 4-10. 

- -SURVEY DATA INPUT (SO+ 

Dle 


p t a ~ o n  M. Dspth lncllnatlon Arlmuth 

Figure 4-10. SDI Window 
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-

To retrieve an existing file, click on "File" at the top of the screen. This opens the "File" pull-- down menu as shown in Figure 4-11. 

tatlon M. Dcpth lnclinatlon Azlmuth 

Figure 4-1 1. SDI File Pull-Down Menu 

Click on "Open." This opens the file dialog box. Highlight the SDI file name to be retrieved. 

Click on [OK] button. The SDI Window is filled with the data from the File, as shown in Figure 4-12. 

1 IaUon M. Dcpth IncllnmUon Azimuth 

Figure 4-12. SDI Window Filled 



Now, click on "File" in the menu bar at the top of the S w e y  Data Input window. When the 

"File" window opens, click on "Return. " 

8. 	 To access the TDI window, click on the [Show TDI] button or click on "Input" menu, then 

click on TDI. Either procedure will display the TDI wiradow as shown in Figure 4-13. 

Figure 4-13. TDI window 



-

To retrieve an existing file, click on "File" in the menu to open the "File" pulldown menu 

m. (Figure 4-14). Then, click on "Open" to display the file dialog box as shown in Figure 4-15. -

Figure 4-14. TDI File Pull-Down Menu 

Figure 4-15. TDI File Dialog Box 
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Highlight the file to be retrieved, and click on the [OK] button. The TDI window is filled with 

the data from the file as shown in Figure 4-16. 

I - -TUBULAR DATA INPUT ~DI]-CWFtOMODl\TEST.VT1 1-id 
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Figure 4-16. TDI Window Filled 

To go back to the Main window, click on the "File" menu again and then click on "Return." 



9. 	 The last file to be retrieved is the PDI file. To access this file, click on the [Show PDI] 

button or click on the "Input" menu and then click on "PDI." Either procedure will display 

the PDI window as shown in Figure 4-17. 
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Figure 4-17. PDI Window 
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To retrieve an existing file, click on the "File" menu to open the pulldown menu, as shown in 

Figure 4-18 and then click on "Open." A file dialog box appears (Figure 4-19). 
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Figure 4-19. PDI File Dialog Box 

Highlight the file to be retrieved, and click on the [OK] button. The PDI window is filled with 

the data from the file. Figure 4-20 shows the data from the sample file. 
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Figure 4-20. PDI Window Filled 
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To exit the PDI window, click on the "File" menu, then click on "Return." This returns the user 

,- to the front window as shown in Figure 4-21. 

PAOMOD1.O \-[:I 
Ellc Input Start ~ l l l h /  Help 

~ulti-PhaseFlow Production Model 
(VelocityString A Nodal Analysis * Gar LIR) 

Prqed F~le Name'3 

WDI F~leName C\PROMODl\TESTWDI 

ITSDI File Name C.\PROMODl\TEST SDI 

TDI File Name C \PROMODl\TEST VTl 
Show TDI 

POI FIISN m m ~  C.\PROMODI\TE!XVPI 

u n ~ tSystsrn ~ n g ~ ~ s h  
I J 

Percent Complete lndlcator 

Figure 4-21. PROMODl Front Window 

Now, all four data file boxes in the front window are filled with the names of the four chosen files. 



At this time, the user can create a project file which contains all four of the input data files. 

Calling up this project file will simultaneously input all four data files for future computation. The 

project file is established as follows: 

10. 	 Click on "File" at the left end of the menu bar. When the pull-down window appears, click 

on "Save project" (Figure 4-22). 
-

Figure 4-22. Project File Pull-Down Menu 

This opens the file save dialog box as shown in Figure 4-23. 

-	 rn0MODl.O 

Elle Input St.r( Iltlllly Help 

Figure 4-23. Project File Dialog Box 
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In the box directly below File Name, type the name of the project file without the extension. 

For this example, the file name is TEST and the extension VJl. Click on the [Owbutton 

to close the dialog box. The project file designator has been added to the list of titles in the 

boxes at the top of the window. This is shown in Figure 4-24. 

- PROMOD1.O I-IQ 
Ellc lnpul Stan L!UllY Mclp 

~ .- .- .. 
/ Multi-PhaseFlow Production Model 
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Figure 4-24. Front Window: Filled 



11. 	Click on "Start" from the menu bar to display the "Start" pull-down menu, as shown in 

Figure 4-25. Click on "Calc and Output" and calculation begins. The percent complete 

indicator at the bottom of the window monitors the calculation process. When calculation is 

complete, the program brings out the "Output" window automatically as shown in Figure 4-26. 

WOMODl .O 

(Velocity S~ Nodal ALlalysis A Gas Lift) 

Project file Name WROMODl\TEST.VJl 
pp; /
WDI File Name C3PROMODl\TEST.WDI 

SDI File Hams C:\PROMODl\TESTSDI 

W I  File Name C:\PROUODl\TEST.VPl 


Unit Systern English 


. 	 .
imtor 

-.. .. 

Figure 4-25. "Start" Pull-Down Menu 
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Figure 4-26. "Output" Window 
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12. 	 The graphics plot in the "Output" window shows the inflowJoutflow performance curves. 

The grid under the plot shows the production parameters at the crossing of inflowJoutflow 

performance curves. The option box on the right of the screen provides available calculation 

options, including choke model, solubility model, and two-phase flow correlations. 

13. 	 To select a choke model, click on the down arrow to the right of the choke model bar to pull 

down the available choke models, as shown in Figure 4-27. Click on the appropriate model 

and the pulldown box disappears and the selected model is displayed in the choke model bar. 

The results are recalculated if the choke model changes. A horizontal bar under the plot box 

monitors the calculation process. 

Figure 4-27. Choke Model Selection 



14. 	 If the reservoir is under solution gas drive, a solubility model is required. There are two 

models available. To select either one of these, first click on the down arrow to pull down 

the selection box (Figure 4-28), make the selection by clicking on the name of the model. 

Figure 4-28. Solubility Model Selection 

15. 	 The user can customize the inflow/outflow performance curves by specifying the points 

plotted. To do this, simply enter the number of poinls in the graph points field. The graph 

is replotted once the recalculation finishes. 

16. 	 To select multiphase correlations for vertical, inclined, or horizontal flow, click on the down 

arrow beside the correlation box to pull down the selection box, as shown in Figure 4-29. 
Make the selection by clicking on the appropriate model. The selected model is displayed in 

the model box. The graph is then updated automatically when the calculation is finished. The 

horizontal bar under the plot box monitors the calculation process. 



Figure 4-29. Correlation Selection Box 

17. There are several buttons in the bottom corner at the right of the screen. These are: 

a. 	 <B. Hole Node> button: Clicking on this button switches the solution node from the 

wellhead node to the bottom-hole node. The inflowloutflow performance curves plots 

bottom-hole pressures against production rates accordingly, as shown in Figure 4-30. 

Figure 4-30. InflowlOutflow Performance Curves with the Bottom-Hole Node 
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b. 	 <W. Head Node> : Clicking on this button switches the solution node from the bottorn- 

hole node to the wellhead node. The inflow/outflow performance curves plot the wellhead 

pressures against the production rate accordingly, as shown in Figure 4-31. 

Figure 4-31. Inflow/Outflow Performance Curves with the Wellhead Node 

18. 	Click on the <Critical Rate Analysis> button to open a window with critical flow rate 
plotted against the tubing ID, as shown in Figure 4-32. 

Figure 4-32. Critical Rate Window 
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In this window there are three white fields where the user can enter the wellhead pressure, 

tubing ID and critical rate. When a new wellhead pressure is entered, the critical rate curve 

is updated based on the new input. To read a particular point on the plot, type in the tubing 

ID. The corresponding critical rate is then displayed in the critical rate field. If the critical 

rate is entered, the maximum tubing ID is then displayed. To return to the previous window, 

click on the <Go Back> button. 

19. 	 Clicking on the <Profile> button displays a group of "child" windows as shown in Figure 

4-33. These windows display several types of output, including flow regime, velocity, liquid 

hold-up, and pressure distribution. Before clicking on the <Profile> button decide the 

number of curves to be plotted in each graph. This is determined by the number of "+" 
signs in the table under the plot box. Clicking on a particular row in the table will switch the 

"+ " on or off. 

-	 Roflle 1-13 

file Wndm 


R 1p.g)- 34m. 

00 W d Q  - 14m2 


FW ( d l  - 56l.6 

Figure 4-33. Output "Child" Windows 



20. 	 There are two ways to bring a particular "child" window to the screen. One way is to click 

on the particular window when a mouse is available. Another is to click on the "Window" 

pulldown menu at the top to display the "Window" pulldown menu (Figure 4-34), then, 

click on the title of the individual plot. 

Figure 4-34. "Window" Pull-Down Menu 

21. 	 The "child" windows can be arranged in two ways, either in "Cascade" or "Tile." To 

cascade, click on the "Window" menu at the top, then click on "Cascade." (Figure 4-35). 

Figure 4-35. "Child" Windows Cascaded 
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22. To arrange the "child" windows in Tile, click on the "window" menu, then click on "Tile." 

The program titles the "child" windows as shown in Figure 4-36. 

Figure 4-36. "Child" Windows Titled 

23. 	 To return to the previous window, click on "File" at the top of the screen, then, click on 

"Return" to go back to the inflow/outflow performance window, as shown in Figure 4-37. 

Figure 4-37. InflowlOutflow Performance Window 
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24. 	 Clicking on the <Go Back> button causes the program to return to the Main window as 

shown in Figure 4-38. 

-
-	 ROMOD~ o Rl*/  
file Input Stad I l t l l b  Help 

1 	 ~ulti-phaseFlow Production Model 

Figure 4-38. PROMODl Main Window 

25. 	 The Help option at the right end of the menu bar opens the Help window. The two options 

available in this window are Assistance.. and About.. . Clicking on Assistance opens the 

window shown in Figure 4-39, which gives phone and FAX numbers and individuals to 

contact for assistance with the program. 
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 ASSISTANCE 

For assistance with this program, contact: 

Weiping Yang or 

Russell Hall 


Maurer Engineering Inc. 

291 6 West T.C. Jester 


Houston, TX. 7701 8 

U.S.A. 


Phone: 71 3-683-8227 
Fax: 71 3-683-641 8 
Telex: 21 6556 

pq 

Figure 4-39. Assistance Window 

Clicking on About.. in the Help window opens a window with information about the 

program, and a listing of the equipment you are using to run the program (Figure 440). 

I About ... 
TI-PHA OW PRODUCTION MODEL lPro ?; k n p  * Nodal Analysls * Gas(Vela:: d 1.Ol 

DEA-67 

Project to Develop And Evaluate Sllm+lole And 


Coiled-Tublng Technology 


BY 
Maurer Enqlneerinq Inc. 

CPU : Intel 00406 I 
Coprocessor : pnsent 
Windows Mode : Enhanced Mode I 
Windows Verslon : 3.1 0 
Free Memory : 5679 KB 

Figure 440. About Window 

26. To leave the program, click on "File" on the menu bar. When the "File" window opens, 

click on "Exit." 





5. 	 Data File Preparation 

5.1 	 SDI DATA 

The SDI Data Input window is shown in Figure 5-1. 

- -SURVEY DATA INFW [SOIi-	 l-l$L 
a l e  	 -

tadon 	 M. Depth lncllnatlan AzimuUl 

Figure 5-1. SDI Data Input Window 

Note the three sets of options that are available. They are: 

1. Depth - Feet or Meters 

2. 	 Inclination - Decimal Degrees or Degrees and Minutes 

3. 	 Azimuth - Angular or Oil Field Measure 

To change any of these, click on the desired option. If not using a mouse, use the tab key to move 

from one field to another, and use the arrow keys to move within a field. As the user moves from one 

value to another, the highlight will move accordingly. Default choices are Feet, Decimal, and Angular, 

respectively. 

Before leaving this Survey Data Input window, set these three options to suit your needs. 

-
5.2 	 TDI DATA -

-	 The TDI Data Input Window is shown in Figure 5-2. 



Figure 5-2. TDI Data Input Window 

There are four blocks of data in this window: 

1. Tubing string data block in the upper left corner 

2. Casing and open-hole data block in the lower left corner 

3. Surface pipe line data block in the lower right corner 

4. Perforation depth, calculation interval and choke size 

Input errors can be deleted only by pressing the <Back Space > key. 

The first column in the tubing string data block is the tubing section description. Only letters and 

numbers are accepted as the input for this column. 

The tubing ID, OD and length are all required for a complete definition of a tubing section. The 

capacity of the tubing (volume) is calculated automatically by the program once the necessary data 

become available. The total length and volume of the tubing is updated every time a change is made to 

the tubing string. These two values are displayed at the bottom of the block. 

The input to the casing and open-hole data block is basically the same; however, the casing OD 

is not required. Also note that the casing and open-hole data input starts at the top and proceeds 

downward. However, for tubing string, the input starts at the bottom and moves upward. 

The surface pipe line input starts from the wellhead. The ID, deviation, and length of each section 

are required. Deviation is the angle relative to the horizontal line. The deviation is positive when flow 

is uphill; negative when flow is downhill; zero when flow is horizontal. The user can leave this block 

blank if there is no surface line in the system. 



-
Perforation depth is the mid-point of the perforation section for a vertical well. For a horizontal - well, it is assumed that all the flow enters the well at the well end, therefore, the perforation depth is - the measured depth of the horizontal well end. 

Calculation interval is used to partition the flow line into a number of blocks. A longer interval 

usually means faster calculation but less accuracy. A shorter interval usually means slower calculation, 

but better accuracy. The user has to decide what interval to use according to the well length,, computer 

CPU speed, and the time available. An interval between 50 to 300 ft should be good in most cases. 

Choke ID is a required input, whether the well is equipped with a choke or  not. It is required so 

that later the user can choose to see how the production changes when a choke is added to the system. 

5.3 PDI DATA 

The PDI Data Input window is shown in Figure 5-3. 
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Figure 5-3. PDI Data Input Window 

The PDI Data Input window is divided into 5 blocks. They are: 

1. Well type block 
2. Production rate input block 
3. IPR curve input block 
4. Fluid properties block 
5. Gas lift option block in the lower right corner 



The gas lift option block is dimed because it is inappropriate for a gas well. When the well lype 

is switched to a solution gas driven oil well, the gas lift option is enabled as shown in Figure 54. 
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Figure 54. PDI Window with Gas Lift Option Enabled 

5.3.1 1 
Only one of either the production rate input block or the IPR curve input block can be 

enabled. When production rate is known, rate block is enabled and IPR curve block is disabled. When 

the production rate is unknown, then IPR curve needs to be defined and rate block is disabled. The input 

fields of the disabled block have a gray background. 



-

The production rate input is straightforward, and is not described in detail here. The IPR 

P curve input depends on the well type selected and the IPR model chosen. Figure 5-5 shows the input- requirements for a gas well using Fetkovich's IPR model (note: only one IPR model is available for gas 

wells). 
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Figure 5-5. IPR Input for Gas Wells 

The three reservoir pressures are the pressures of the reservoir at different stages of 

production. The user can input 1, 2, or 3 pressures, depending on the data available. 

C and n are both constants determined from well testing results when reservoir pressure is 

at Pi. They are used to predict IPR curves for reservoirs with a different pressure than Pi. The 

prediction equation is displayed at the bottom of the block. 



-- 

Click on the <IPR Curve> button after the relevant data are entered to open a window 

with the IPR curves displayed, as shown in Figure 5-6. 
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Figure 5-6. IPR Curves 

The curves can be saved or printed by clicking on the <Save> or <Print> buttons, 

respectively. The user can return to the previous window by clicking on the <Go Back> button. 

IPR input requirements are different when the reservoir is under solution gas drive. 

Selecting solution gas driven oil well under well type displays the IPR input shown in Figure 5-7. 
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Figure 5-7. IPR Curve Input for Oil Wells and Vogel's IPR Model 
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-
 Vogel's equation requires a current reservoir pressure and the maximum production rate 

under the current reservoir pressure. The user can enter up to 3 pairs to evaluate the production at 
,-

- different stages of reservoir depletion. Again, clicking on the <IPR Curve> button opens a window 

displaying the IPR curve, as shown in Figure 5-8. 
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Figure 5-8. IPR Curve for Oil Wells with Vogel's Equation 



Another equation that is available for oil wells is the PI equation. It is useful for reservoirs 

with pressures above the bubble point pressure. These conditions result in single liquid-phase flow in 

the reservoir. To activate the PI equation, click on the down arrow beside the IPR model to pull down 

the IPR model selection box, then click on "PI equation." The input fields for the PI equation are 

displayed in the IPR curve block, as shown in Figure 5-9. 
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Figure 5-9. IPR Input for Oil Wells with the PI Equation 
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-
The PI equation requires a current reservoir pressure and the corresponding productivity 

-
 .- index at the current pressure. Up to 3 pairs can be entered into the IPR block to evaluate the 

performance at the different stages of production. An example of the IPR curves with the PI equation 

is shown in Figure 5-10 
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Figure 5-10. IPR Curves for Oil Wells with the PI Equation 

The following are the input parameters for this block: 

1. Gas specific gravity 
2. Oil API gravity 
3. Water specific gravity 
4. Outlet pressure 
5. Gaslliquid ratio 
6. Waterlliquid ratio 
7. Surface temperature 
8. Bottom-hole temperature 

The outlet pressure can be separator or wellhead pressure when no surface line or choke 

is present in the production system. 



5.3.3 Gas Lift Input 'Black 

This block lists all of the parameters required for a continuous gas lift operation. It is 

available only when oil well is selected. The user has to specify the injection depth and the injected gas 

specific gravity. There are two options available for specifying gas injection amounts: 1) fixed gas 

injection rate, and 2) tixed injection gasfliquid ratio. To select either one, click on the radio button 

preceding each option. Note: Injection gaslliquid ratio refers to the amount of gas injected per barrel 

of liquid produced. It does not include the formation solution gas, i.e., it does not equal the produced 

gashquid ratio. 
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7. Bug Report or Enhancement Suggestion Form 

Name: Company: 

- Address: City: State: 

Phone No.: Fax No.: Date: 

BuglProblem Report Enhancement Suggestion 

Program Name and Version Number: 

BuglProblem Description or Enhancement Suggestion: 

Regarding the Bug Report, please answer the following questions: 

Cornouter Svstern Brand: 

Chip: 386286 486 pentiurn 

Type: Laptop ~o tebook  otherDesktop 
RAM: MB m: MHz 

-:
 yes No U h o w n  

Printer Type: (for printing error only) 

Plotter: (for plotting error only) 

Within Network System: yes  No Type: 

Video Type: EGA VGA SVGA Mono LCD 

Video Card Ram: (video problem only) 

Operating Svstern 

MS-DOS Version No.: MS-Windows Version No.: (for Windows applicatiow) 

OS2 MS-Windows NT Version No.: 

Other 

Data Causing Bug 

Will be mailed on diskette Will be faxed Attached None 

Other Comments: 

- Please send or fax to: 
Lee Chu 

F MAURERENGINEERINGINC. 
2916 West T.C. Jester- Houston, TX 77018-7098 

Ph.: 7131683-8227 Fax: 7131683-64181 





	The PROMODI program was developed as part of the Drilling Engineering Association's DEA- 67 project to "Develop and Evaluate Slim-Hole and Coiled-Tubing Technology." The program calculates oil, water, and gas production rate, as well as pressure drop along the wellbore, based on the wellbore configuration and reservoir properties. It can be used for 1) velocity string design, 2) nodalanalysis, and 3) gas-lift calculations
	MULTIPHASE CORRELATIONS FOR FLOW IN WELLBORE OR SURFACE LINES-As discussed earlier, the modeling of production systems involves a large amount of calculation of multiphase flow in wellbores and surface pipe lines. There is a number of correlations available in-the industry for this purpose. However, none of the multiphase flow correlations works well across the full range of conditions encountered in oil and gas fields. Thus, in order to get a realistic tubing-performance curve, great care should be taken to ensure that the input variables are as realistic as-possible. The correlan'ons described belo~v use SZ units. The pressure drop calculated from these-correlations has to be converted to English units before being used.
	The value of roughness may be very small but eld never becomes smaller than the value for the pipe itself. At the transition zone to slug flow, eld may approach 0.5. Between these limits, eld can be obtained from the following equations which were developed from Figure 2-14.
	The program was compared to 108 sets of well data. The results were found superior to dry-gas well predictions. The Gray correlation can be used to evaluate gas condensate wells by generating tubing performance J curves and comparing them to reservoir performance. Although the above restrictions should be considered, several calculations made with up to 300 bbllMMscf indicated less than a 10% error compared to data
	Gas Well Load-UD IdentificationThe liquid exists in the wellbore in two forms: 1) the liquid film along the wall of the pipe and 2) liquid droplets entrained in the high velocity gas core. Two models were developed by Turner et al., in 1969, to predict the onset of load-up based on two different assumptions
	Chokes are frequently installed in wells to restrict flow rates to desired levels. They normally operate in "Critical" or "Sonic" flow conditions (i.e., the velocity of the fluids through the choke reaches a level identical to the velocity of sound, pressure or compressional wave). Flow then becomes independent of downstream disturbance of pressure, temperature, or density because the disturbance cannot travel in the upstream direction
	In the box directly below File Name, type the name of the project file without the extension. For this example, the file name is TEST and the extension VJl. Click on the [Owbutton to close the dialog box. The project file designator has b



